
3-9 DECEMBER ISSUE 428

INSPIRAT ION  IDEAS  IN-DEPTH REVIEWS

T H E  W O R L D ’ S  B E S T-S EL L I N G  D IG I TA L  P H O T O  M A G A Z I N E

FAMILY 
BUSINESS

PRO TIPS FOR SHOOTING CAPTIVATING 
AND CANDID PORTRAITS OF CHILDREN

SIGMA 100-400MM 
F/5‑6.3 DG DN OS | C
WE TEST SIGMA’S COMPACT 

ZOOM FOR SONY AND 
LEICA CAMERAS 



REIMAGINE
MIRRORLESS
The revolutionary Canon EOS R
System lets you completely
reimagine the possibilities
of photography and video.

EOS R

*  Winter cashback is available on selected products between 16th November 2020 and 8th January 2021 inclusive from 
participating retailers. Full Terms and Conditions apply. For more information visit canon.co.uk/wintercashback/

Find out more at  
canon.co.uk/cameras/eos-r-system

Live for the story_

£220
Cashback 

now available*

£110
Cashback 

now available*

EOS RP



JOIN THE CLUB...
Welcome to the world’s  
No.1 weekly digital 
photography magazine. 
If you’re already a 

reader, thanks for your continued 
support and involvement; if you’re 
new to Photography Week, you’ve 
come to the right place! In addition 
to expert advice, brilliant tips and 
step-by-step tutorials, every issue 
features interactive galleries of the 
best new photos, how-to videos on 

essential shooting and editing 
techniques, and in-depth reviews 
of the latest camera kit. 

But that’s not the whole story. 
Photography Week is more than 
a magazine – it’s a community 
of like-minded people who are 
passionate about photography. 
To get involved, just follow any 
of the links below and share your 
shots and comments – your photo 
might even appear on our cover!

W E L C O M E

We’re more than just a magazine – read on and discover the many  
ways you can interact with and enjoy Photography Week

JOIN THE PHOTOGRAPHY WEEK 
COMMUNIT Y AND START SHARING! 

FACEBOOK
http://bit.ly/39py9lg

TWITTER 
http://bit.ly/2vGadLP

FLICKR 
http://bit.ly/2VIgsJO



C O N T E N T S 
FIND OUT WHAT’S INSIDE THIS ISSUE

N E W S

400MP IMAGES COME TO 
THE FUJIFILM GFX 100 
Pixel Shift Multi-Shot feature 
lands with firmware upgrade

F E AT U R E

FAMILY BUSINESS 
Pro tips for capturing beautiful 
portraits of babies and families

P H O T O S

GALLERY 
Our pick of the best reader 
images from around the world

I N S P I R AT I O N

MARRIAGE WOWS 
Enjoy the best wedding 
photography of 2020

C R A S H  C O U R S E

FLUID MOTION 
Create a figure from images 
of paint suspended in water 

P H O T O S H O P

GET MORE FROM LEVELS 
Discover the hidden powers of 
this versatile image-editing tool
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I N S P I R AT I O NP H O T O S

P H O T O S H O P

F E AT U R E

G E A R   
SIGMA 100-400MM F/5‑6.3 DG DN OS | C
Sigma redesigns its 
‘light bazooka’ lens 
for Sony E and Leica L 
mounts. Can it improve 
on the original? Find 
out in our review 

Turn to our Subscr ibe 
page to learn more

JUST  
39¢/39p 

PER ISSUE! 
WHEN YOU SUBSCRIBE

SEE THE SUBSCR IPT ION
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W H AT ’ S  H O T
THE WEEK’S TOP HEADLINES IN PHOTOGRAPHY

SN E W

THE FUJIFILM GFX 100 CAN 
NOW CAPTURE 400MP IMAGES

he already highly capable 

Fujifilm GFX 100 has added 

another string to its bow with 

the ability to capture 400-megapixel 

images, courtesy of new firmware. 

With its 102MP medium-format image 

sensor, the GFX 100 could already take 

enormous (and highly detailed) files, but 

the new firmware version 3.00 adds the 

much-anticipated Pixel Shift Multi-Shot 

feature, which captures and combines 

16 frames into a single 400MP image.

This is made possible by the GFX 

100’s in-body stabilisation system, which 

is designed to counteract camera shake 

by making micro-adjustments to the 

sensor. Pixel Shift Multi-Shot turns this 

technology on its head, shifting the 

image sensor by 0.5 pixels between 

each frame to incrementally record 

high-resolution RGB pixel information 

while capturing 16 raw images.

You can then open these files into 

Pixel Shift Combiner to merge them into 

a 400MP image, which can be outputted 

as a DNG raw file in software. It appears 

that this process isn’t an in-camera one 

(as it is with cameras like the Olympus 

OM-D E-M1 Mark III, which captures 

16 frames from its 20.1MP sensor and 

combines them into an 80MP raw file). 

Rather, it seems the file merging needs 

to be conducted on a computer – and 

this can be performed via the tethered 

capture functionality that’s also 

facilitated by the new firmware.

Fujifilm says the GFX 100 offers 

“unparalleled colour reproduction, with 

next to no false colours,” making it the 

ultimate way to record images “that 

require immense color fidelity and the 

reproduction of fine details”. 

T

New firmware adds Pixel Shift Multi-Shot for ‘unparalleled’ colour and detail
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JOIN THE REVOLUTION
Meet the Canon EOS R5 and Canon EOS R6 – the full-frame mirrorless 

cameras that are changing the game for photographers and film-makers

anon’s EOS R series of  
full-frame mirrorless cameras 
deliver all the benefits of 

large-sensor photography and  
movie-making in bodies that are 
more compact and lightweight than 
traditional DSLRs. The latest pro-spec 
Canon EOS R5 and Canon EOS R6 
redefine mirrorless performance, 
offering advanced, industry-first 

features that set a new benchmark 
for hybrid cameras. As the flagship 
of the EOS R range, the EOS R5 packs 
the cream of cutting-edge Canon 
technology. Capable of recording 
sensational 45-megapixel high-
resolution stills in bursts up to 20fps, 
it never misses a beat. With 5,940 
autofocus positions, Animal Tracking 
and Eye Detection AF, the EOS R5’s 

next-level Dual Pixel CMOS AF II 
system offers exceptional focusing 
precision. Powerful image stabilisation, 
achieved through a combination of 
an in-body image stabilizer and 
lens-based stabilisation, delivers up 
to eight stops of shake reduction for 
super-sharp images every time.
	 The EOS R5 is a fully-featured tool 
for all filmmakers too. It’s the first ever 

C

With its 45MP full-frame CMOS sensor, 8K RAW video 
capture and in-body image stabilisation, Canon’s EOS 
R5 is the ultimate hybrid camera

CANON EOS MIRRORLESS EOS PROMOTION



Canon EOS R5 Canon EOS R6

The Canon EOS R6 offers confidence-inspiring EOS handling, 
‘deep learning’ autofocus and silent, high-speed capture

EOS PROMOTION

REVOLUTIONARY
RF LENS MOUNT

CANON RF LENSES

At the heart of the Canon EOS R system 
is the innovative RF lens mount. Its 
combination of a large diameter and 
shorter flange distance from the mount to 
the sensor allows for large-aperture lens 
designs that offer superior image quality. 

The future-proof 12-pin RF mount 
features four more electrical contacts 
than the EF mount, and enables higher-
bandwidth communication between 
the lens and the camera. The increased 
amount of data being passed back and 
forth enables a host of improvements, 
including high-precision autofocus 
tracking with Eye Detection AF, superior 
image stabilisation, and real-time Digital 
Lens Optimizer, which corrects for 
distortions and aberrations without any 
effect on shooting performance.

The EOS R system is supported by a growing 
range of dedicated Canon RF lenses. These 
include unique zooms, such as the bright, 
prime-quality Canon RF 28-70mm F2L USM and 
discreet Canon RF 70-200mm F2.8L IS USM, as 
well as pioneering fixed-focal-length lenses like 
the Canon RF 800mm F11 IS STM. You can even 
use your EF and EF-S lenses on an EOS R series 
camera, via a range of EOS R mount adapters.

full-frame mirrorless camera to 
record cinematic 8K 12-bit RAW video 
up to 30fps internally, as well as 
high-frame-rate 4K to 120p for smooth 
slow-motion playback. You can even 
extract 35MP stills from 8K video clips, 
so you can find and freeze the perfect 
moment in your own time.
	 If you don’t need the 8K video 
specification, but still want to step up 
to professional mirrorless performance, 
then the EOS R6, with its manageable 
20.1-megapixel file size, is a great 
choice. Like the EOS R5, it offers up 
to 12fps shooting with its mechanical 
shutter, as well as a silent electronic 
option that captures high-speed bursts 
at up to 20fps. It can also record crisp 
and detailed 4K video footage at up to 
60p, and features Canon Log and HDR 

PQ options if you need to capture 
more dynamic range.
	 The EOS R6 shares the same 
groundbreaking intelligent autofocus 
technology as the EOS R5. Powered 
by the new DIGIC X processor, the 
Dual Pixel CMOS AF II system stays 
locked onto people even if they turn 
away from the camera, and it can even 
identify and track cats, dogs and birds 
with its intelligent AF.
	 You’re able to push the EOS R6’s 
sensitivity all the way to ISO102,400, 
which means it’s also the perfect 
camera for low-light photography. 
Its in-body five-axis image stabilizer 
works co-operatively with stabilised 
RF lenses to provide up to eight stops 
of stability for sharp handheld results 
as light levels drop.



PRO
TAYLOR BRADY

 CAMERA: 
CANON EOS 7D MARK II
Taylor has been working 

as photographer for 
around nine years. She’s 
explored lots of different 

genres, but portraiture 
was always her main 

interest, and after 
completing her degree 
she set herself up as a 

freelance photographer, 
specialising in newborn 
and family photo shoots 

at her home studio.

Professional family portrait 
photographer Taylor Brady shows 
enthusiast Jonathan how to take 

enagaging pictures of babies 

FAMILY 
BUSINESS

 APPRENTICE
JONATHAN 

CROOK
 CAMERA: 

CANON EOS 760D
Jonathan is a keen 

camera enthusiast who’s 
looking to improve his 
portraiture and lighting 
skills. His teenage son 
is an aspiring actor, so 
Joanthan would also 
like some guidance 
on posing subjects, 
so that he can shoot 
professional-looking 
portraits for his son’s 

portfolio.

UT R EF E A



UT R EF E A

TECHNIQUE ASSESSMENT
Taylor started out by showing Jonathan how to set up 

his camera to help him capture perfect portraits

SHOOT IN MANUAL 
The portraits in the morning 
session were all going to 
be lit with natural light 
coming through the large 
window in Taylor’s living 
room – this would give the 
images a soft, gentle feel, 
especially as the lighting 
was very overcast on the 
day. Thanks to the total 
cloud coverage the lighting 
was consistent throughout 
the shoot, so Taylor set both 
her camera and Jonathan’s 
to Manual mode and dialed 
in settings of 1/160 sec, 
f/2.8 and ISO800.

SHOOT RAW 
Taylor suggested Jonathan 
set his Canon EOS 760D 
to shoot raw files, as these 
capture much more detail 
than JPEG files, which are 
processed and compressed 
in-camera. This additional 
detail is hugely beneficial, 
especially if an image is 
a little overexposed or 
underexposed, as you can 
restore blown out highlights 
or lift dark shadows with the 
push of a slider in software.



UT R EF E A

TAYLOR SAYS 
For our morning session we met up with 
mum Becky and her six-month-old baby 

daughter Penelope. Prior to the shoot I had 
asked Becky to bring a few changes of clothes, 

and I also had a Christmas set I wanted to try 
later. Having a good selection of outfits, and 

different backgrounds, helps to give the baby 
portraits some variety. To get this shot I asked 
Becky to get Penelope sitting upright on this 
soft mat, and I gave her a toy camera to play 
with. The window light is coming in from the 
right, so as she’s looking in that direction her 

face and eyes are nicely lit, with the rest of her 
in soft shadow. I had Becky sat just out of shot 

so that she could catch Penelope if she fell 
forwards or backwards.

HOT SHOT
#1

PRO TIP
USE FACE DETECTION  

FOR EASY FOCUS

Face detection is getting increasingly 
smart in DSLRs and mirrorless cameras, 
and it can be very handy when shooting 
small children or animals, as both subjects 
tend to move in unpredictable ways. The 
algorithm finds the face, and continually 
focuses on it until you take the shot.

LENS 35mm f/2
EXPOSURE 1/160 sec, f/2, ISO200
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JONATHAN SAYS 
For this shot we asked Becky to carefully lower baby 

Penelope into this small wooden crate lined with a soft 
blanket. I used Live View to focus, and as I was using a 

60mm lens I could get a tight frame-filling portrait. I think 
Penelope is looking at her mum or Taylor here, and it makes 
for a nice off-camera portrait. I opened the aperture to f/2.8 
and set the ISO to 400, which helped me get a fast enough 
shutter speed – 1/160 sec – to shoot handheld. Taylor said I 
should aim to get a shutter speed equal to or faster than my 
focal length, so 1/100 sec at 100mm or 1/200 sec at 200mm 

and so on. As I was working with a Canon APS-C body I 
then had to multiply the shutter speed by 1.6, so 1/100 sec 

becomes 1/160 sec, for example.

LENS 60mm f/2.8
EXPOSURE 1/160 sec, f/2.8, ISO400

HOT SHOT
#2
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JONATHAN SAYS 
You often think about high-angle photos being associated 
with drones looking down on cities from high above, but it 
was nice to replicate this top-down shooting method here. 
I carefully leaned over Penelope and held my camera high 

up, using the tilting LCD screen on my EOS 760D to compose. 
I held the camera securely, ensuring I wore my camera strap 

around my neck for extra safety. I also pulled some funny 
faces to get Penelope to up towards the camera. I composed 
leaving a bit of space on the right so she was off-centre, and 

took a burst of images from this high-angle perspective, 
hoping that one would be focused correctly.  

LENS 35mm f/2
EXPOSURE 1/160 sec, f/2, ISO200

HOT SHOT
#3

EXPERT INSIGHT
GOVERNMENT GUIDELINES

We were in a part of England where it was safe for up 
to six people from different households to meet up 
indoors, but we also made sure that Jonathan and Taylor 
wore face visors and kept a distance of one metre when 
possible. Taylor also makes sure everyone coming into 
her studio scans the QR code for the Track and Trace app. 
Be sure you follow the government guidance for your 
location, as this will differ depending on where you are in 
the UK, and note that guidance changes frequently.
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TAYLOR SAYS 
For babies of Penelope’s age I’d usually expect to get 

around 30 minutes of shooting time in a two-hour shoot, as 
they can take a while to settle down – having the heating on 
so it’s warm definitely helps them settle sooner. Penelope 
was a superstar and had no tantrums whatsoever. For this 
Christmas-themed setup I placed prop presents behind 

her and sat her in this ‘snow’ material. The ‘snow’ came out 
looking a bit blue, so I tweaked the white balance in post to 

make it look wonderfully white and airy.

PRO TIP
MACRO LENSES

Macro lenses are great for portraits, as not only 
do they allow you to get much closer than normal 
lenses, so you can focus on the finer details like an 
eye, or a baby’s tiny hands, for example, but they 
usually have wide apertures, such as f/2.8, making it 
easy for you to blur the backgrounds of your portraits.

LENS 35mm f/2
EXPOSURE 1/160 sec, f/2, ISO200

HOT SHOT
#4
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JONATHAN SAYS 
We asked Michael and Sophie to sit on a large wooden 

bench for a few shots, with baby Romaeo sitting on 
Michael’s lap. I love this photograph because there’s a strong 
interaction between the parents, and also good eye contact 

with Romaeo, who looks very happy. An aperture of f/3.2 was 
enough to keep the three of them in focus, but I found it tricky 
to get a good composition with the full aspect ratio in portrait 

or landscape orientation, as there was too much empty 
space. In the end this square crop has worked well – and it’s 

how an image like this would typically be cropped for sharing 
on social media sites such as Instagram.

LENS 50mm f/1.8
EXPOSURE 1/2500 sec, f/3.2, ISO320

HOT SHOT
#6

EXPERT INSIGHT
KEEP THEM DISTRACTED

While it’s easy enough to ask the parents to look 
towards your camera, it’s not as simple with babies. 
Holding a colourful toy in one hand and waving it around, 
or having somebody else do this, usually works pretty 
well for getting babies looking towards your camera, 
so you can capture that perfect family photo.
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JONATHAN’S COMMENT
To give this final portrait from the morning shoot a 

Christmas vibe, we asked Becky to change Penelope 
into this Christmas pudding outfit that Taylor had brought 

along. While she was doing that we set up the scene, 
keeping it simple, with prop presents in the background 

and a large red tartan cushion for Penelope to sit on. 
Following Taylor’s lead I crouched low so that I was at 

eye level with Penelope, and framed up to get the baby 
and presents all in one shot. Shooting with Taylor was 
a fantastic experience, and I’m really looking forward 
to using the portrait skills I picked up when I’m taking 

headshots for my son’s acting portfolio at home.

TAYLOR’S VERDICT
Jonathan was a great sport throughout the day, and 
it was lovely to see him capture some fantastic and 
intimate moments as his confidence grew. Shooting 

inside in a studio setting in the morning and outside with 
natural light in the afternoon should hopefully give him 

more options when he’s taking his family photos. It would 
definitely be worth Jonathan investing in an inexpensive 
reflector and a budget flashgun to expand his lighting 
options, and some decent backdrops, which are handy 

for creating different looks in the studio. But he’s got the 
core equipment, and an eye for a good shot, so he’s well 

on his way to taking some brilliant family photos.

SHOT
OF THE
DAY!

LENS 35mm f/2
EXPOSURE 1/160 sec, f/2, ISO200
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1CARRY SPARE BATTERIES 
Carrying a spare battery may 

seem obvious, but it’s vital on a shoot. 
Have plenty of batteries on charge – 
you don’t want to end a shoot early 
because you ran out of power.

2FOCUS ON THE EYES 
The eyes are usually the most 

important part of a portrait, so this 
is where you should position your 
active AF point when shooting. When 
working with wide apertures, like f/1.8, 
check on the LCD to make sure your 
pictures are coming out sharp.

3GET DOWN TO EYE LEVEL 
Make your images look more 

professional and intimate by crouching 
down so that you’re level with the 
baby’s eyes. If you’re struggling to 
manage this throughout a long shoot 
a tiltable LCD screen will help.

4PROPS 
Having a big box of props helps 

keep your young subjects interested 
and having fun, and also allows you to 
get a bit of variety in your images.

5KEEP THE ROOM WARM 
When working indoors I always 

crank up the central heating, as I find 
babies take much longer to settle 
when it’s cold. For outdoor shoots 
make sure they’re wrapped up nice 
and warm too.

6ALLOW TIME FOR SETTLING 
I expect to get about 30 minutes 

of good behaviour out of six-month 
old babies, so factor in time for them 
to settle, and then try and take as 
many pictures as possible while 
they’re in a good mood.

7KEEP SOOTHING SONGS ON STANDBY 
Parents usually have songs or 

videos on their phones that will help 
to stop their babies crying and soothe 
them if they get upset, helping you get 
back to capturing happy smiles.

8MODEL RELEASE 
These are readily available online 

to download and print out for free, 
and I always recommend you get your 
clients to fill them out, so you have a 
written agreement of what you can do 
with the images, payment, and so on.

9WATCH THE BACKGROUND 
Always make sure to check for any 

distractions in the background of your 
portraits that could pull the viewer’s 

eye away from your subject. 

10KEEP CONVERSATION FLOWING 
Talk to the parents throughout 

the shoot, show them your shots, 
interact with babies to get their 
attention, and generally keep the 
conversation flowing, as this will result 
in much better poses than if you’re 
shooting in an uncomfortable silence.

TAYLOR’S TOP 10 TIPS



1 FAST 35MM PRIME LENS
Taylor uses a Canon EF 35mm f/2 IS USM lens, which 

has an equivalent focal length of 56mm on her APS-C EOS 
7D Mk II. This is an ideal focal length for mid-length portraits, 
and has a wide maximum aperture of f/2, making it easy to 
blur backgrounds. It also has Image Stabilization to reduce 
camera-shake when hand-holding the camera and shooting 
using natural light.

2 CANON EOS 7D MARK II BODY
The 7D Mark II camera body is amazing for working 

in tough lighting scenes. Taylor often works with natural 
lighting rather than artificial flash, and the camera’s high-ISO 
performance is very good, while shooting in raw provides 
plenty of extra highlight and shadow detail. Taylor says she’d 
love to upgrade to a full-frame Canon body in the future, but 
the 7D Mark II has served her so well that she’s not in a rush 
to go out and get one.

3 A ‘NIFTY FIFTY’ PRIME LENS
One of Taylor’s go-to lenses is Canon’s EF 50mm 

f/1.8 II, as being a prime lens it offers excellent image 
quality, and it also has a super-fast f/1.8 maximum aperture, 
so it can flood the image sensor with light and allow Talyor 
to capture beautifully defocused backgrounds. These are 
often called ‘nifty fifty’ lenses, because they’re so affordable, 
with the latest Canon EF 50mm f/1.8 STM lens retailing for 
around £100/$125.

4 SANDSTRØM SWCAMBP16 BACKPACK
This is Taylor’s trusty backpack, which she takes to 

all her location shoots. It safely holds all of her lenses and 
lighting kit thanks, which are protected by padded internal 
dividers, and has compartments and pockets for her 
memory cards, spare batteries, business cards and more. 
There’s padding on the straps for extra comfort, and buckles 
as well as zips to make sure nothing gets lost.

ESSENTIAL GEAR
The kit Taylor relies on for capturing pro-quality family portraits

UT R EF E A

1

3

2

4
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PRO TIPS 

USE A REFLECTOR
A reflector offers huge bang for 
your buck, as it’s inexpensive but 
make a big difference to your 
lighting. Whether you’re using the 
available natural light or flash, you 
can position a reflector to fill in 
shadows and make the lighting 
look more even. We used a 5-in-1 
reflector which has gold, silver, 
white and black sides, and serves 
as a diffuser when no cover is fitted. 
As you can see here the white side 
lifts shadows nicely, while the gold 
side gives them a warmer quality.

PRECISE AUTOFOCUS
Free of their face masks and safely 
spaced out when shooting outside, 
Taylor and Jonathan reverted back 
to using optical viewfinders and the 
more accurate phase detection AF. 
They used Single-point AF mode 
so they could choose the specific 
part of the frame they wanted to 
focus on, generally preferring the 
more accurate central AF point.

REVIEW YOUR SHOTS
To build a good rapport with your 
clients it’s a good idea to show 
them some of your best photos 
on the LCD screen. It’s also worth 
zooming in and checking images 
are pin-sharp and that your 
exposure is good, as it’s easier to 
reshoot than fix problems later.

NEWBORN & SIBLING  I aim to capture the soft nature and beautiful moments 
shared between family in shoots. This ‘big sister, little sister’ photo is a personal 
favourite of mine.

MILK BATH I like the soft blend of 
tones created by the milk bath in this 
photo. The milk bath gives the photo a 
more interesting look than a standard 
studio baby shoot.

MATERNITY This photo is a different 
style to what I usually shoot in – the 
colours and tones are darker, but I 
believe it works effectively for the 
subject of this photo.

TAYLOR’S TOP PICS
NONE

WHITE

GOLD



AVAILABLE ON YOUR DEVICE NOW!

To find out how you can get Photography Week delivered straight  
to your device every week for just a few pennies, simply search  

for Photography Week on any of the platforms below

SUBSCRIBE TODAY AND ENJOY 
PHOTOGRAPHY WEEK FOR 
JUST 39C/39P AN ISSUE*  

S U B S C R I B E

http://bit.ly/2txbB2Bhttps://apple.co/2RjoI0a http://bit.ly/36kQ7TC

*Available for a limited time only. Standard subscription offer varies across platforms/devices – please refer to specific store for the most up-to-date offer



X POSURE
THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

CALM BEFORE THE STORM
RAY ABRAHAMS

“The Pilgim of Brixham (BM45) making its way across Tor Bay in Devon, 
dwarfed by the cruise ship Zaandam as storm clouds gather overhead.”

https://bit.ly/36TqrQx



THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

TOO WET TO GO OUT
DAVID FEUERHELM

“I shot this in Senate House Passage in Cambridge, UK, on my Nikon D750 
with a 35mm f/1.8 lens. I processed the image in Silver Efex Pro.”

https://bit.ly/3flC9Hi



THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

HOT DOG
GILL STAFFORD

“An advertising figure outside a seaside food kiosk in Bridlington, Yorkshire, UK.”
http://tiny.cc/9vsf1y



MISSIN’ HIS FISHIN’
SHANNON O’SHEA 

“This is a black-crowned night heron with a recently caught smallmouth bass at 
Wildwood Lake in Harrisburg, Pennsylvania. These birds kept us entertained all 

summer, and I miss them already – although I’m sure the fish don’t!”
http://tiny.cc/5wwn7y

THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

PHOTOGRAPHY WEEK WANTS YOUR PHOTOS! 
Taken a portrait you’re particularly proud of? Shot a sensational sunset you’d like to 
show off? Then join the Photography Week Facebook community and share your best 
photos today! You’ll get feedback from fellow readers and the Photography Week 
team, plus the chance to appear in Xposure, or even on our cover!

FACEBOOK
http://bit.ly/39py9lg

FLICKR 
http://bit.ly/2VIgsJO



  

he winners of International Wedding 
Photographer have been 
announced, showcasing a selection 

of captivating images ranging from the 
informal and spontaneous to elaborately 
staged set pieces. Australian photographer 
James Simmons took top prize for his 
striking mono image of a silhouetted groom 
and brightly lit bride against contrasting 
white and black backdrops (above, top-left).

Simmons says of his winning image: “The 

Winners of International Wedding Photographer or the Year 2020 are announced

Ying Yang symbol instantly came to mind, 
and later as I refined the image in Photoshop 
the king and queen chess board design was 
also an influence that worked well visually.”

Simmons also won the Black & White 
category, while prizes were also awarded 
in categories including Bridal Party, Dance 
Floor and Epic Location. Click the link to see 
all the winning and commended images at 
the competition website, and to read the 
stories of how they were created.

I T ’ S  C O O L ,  T H AT
THE BEST THING WE’VE SEEN THIS WEEK

I N S P TI R A OI N

THESE ARE THE WORLD’S 
BEST IMAGES OF THE BIG DAY
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James Simmons – Grand Winner and 1st place, Black & White Midhat Mulabdic – 1st place, Solo Portrait

Virginia Strobel and Evan Cikaluk – 1st place, Epic Location Antonio Crutchley – 1st place, Engagement/Non Wedding

SEE MORE IMAGES
ht tps : //b i t . ly/37noe03



In this Crash Course we’ll 
show you how to craft a 
colourful dancer image from 
a series of photos of paint, 

using a combination of shooting skills 
and Photoshop techniques. 

First, we’ll get set up to shoot vibrant 
photos of paint by capturing the colours 
as they travel through water. Once this is 
done, we’ll head into Photoshop, where 
we’ll warp the photos into the shape 
of our springing dancer. As such, this is 

effectively two techniques in one – so 
if you’re mainly interested in capturing 
beautiful paint abstracts you can follow 
along with the first part, and if you’d 
rather work on the Photoshop skills, 
you can skip the shooting part and use 
the supplied images to craft your own 
painterly figures.

For the shoot, we need a clear 
container full of water; a fish tank is ideal, 
but any clear plastic or glass container 
will do. You can use natural light at a 

push, but you’ll get better results with an 
off-camera flash – any budget flashgun 
will do. The flash helps to bring out the 
colours in the paints, and freezes the 
action as the paint travels through the 
tank of water, and we’ll show you how 
to get set up with your off-camera flash, 
and how to expose for the shot.

We’ll then move on to the Photoshop 
part of the technique. It might seem 
complicated, but it’s actually much 
easier than it looks…

L IQUID MOTION
James Paterson shows you how to reshape images to create a stunning 
digital abstract figure, using both in-camera techniques and Photoshop 

2
HOURS

C R A S H  C O U R S E 
ESSENTIAL PHOTO SKILLS MADE EASY

S K I L   L   S



THE SETUP PHOTOGRAPH PAINT DROPS

S K I L  L   S

1  FISH TANK
A small fish tank like this is ideal, 
but any plastic or glass container will 
work. Ensure the glass is as clean as 
possible before you start filling the 
tank with water. You’ll need to refresh 
the water after every few shots, so this 
is best done near to a sink.

4  BLACK BACKGROUND
A plain piece of card can be used to 
make a black backdrop. This helps to 
make the paints stand out, and also makes 
it easier to combine several images of 
the paint later on – we can simply blend 
them using the Lighten blending mode in 
Photoshop, which effectively cancels out 
the black backdrop.

3  REFLECTOR
By positioning a reflector opposite 
the flash on the other side of the tank, 
we can bounce the flash light into the 
shadows to even out the lighting. As 
such, it’s a simple and cheap means 
of creating a second light source for 
your subject.

6  CAMERA SETTINGS
As a starting point for your exposure, 
set your camera to Manual mode 
and select an aperture of f/8, 
ISO100 and a shutter speed of 1/200 
second. Set the flash to manual at 
1/2 power and take a test shot – if 
it’s too bright, reduce the flash power 
until it looks just right.

2  SPEEDLIGHT
An off-camera flash is the best way 
to illuminate the paints, as it gives your 
images a clarity that’s hard to achieve 
with natural light alone. Position the 
flash to one side of the tank, angled 
slightly away from the backdrop so 
that it doesn’t spill onto it.

5  WIRELESS TRIGGER
A wireless trigger will enable you to 
fire your off-camera flash remotely. 
If you don’t have one, you could set 
your flashgun to optical remote mode 
and use your camera’s pop-up flash 
to trigger it. Or, alternatively, you can 
use a flash that’s wirelessly compatible 
with your camera.

1
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3
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Get set up for paint abstracts with these bits of kit



HOW TO SHOOT PAINT ABSTRACTS

S K I L  L   S

2

THE DROP SPOT
Before you start dropping paints into the water 

you’ll need to pre-focus on the spot where 
they’ll land. Hold an object like a spoon in the 

centre of the water, focus on it and then switch 
your lens to manual focus in order to lock the 
focus. Now drop the paints in the same spot.

MIX YOUR COLOURS
Try pouring more than one colour into the 

water at once, as the best photos will be those 
where the paint streams intertwine with one 
another. Use contrasting colours and bold 

shades. If need be you can always change the 
colours in Photoshop using the Hue/Saturation 

command (Cmd/Ctrl+U).

3

CHOOSE YOUR PAINTS
Acrylic paints will work best for this as they 

don’t mix with water, so they’ll stay clumped 
together when you drop them in the water. 

If the paints are too thick, try mixing them with 
a dash of white spirit to thin them. Experiment 
with the height from which you pour the paints 

into the water.

1



1  DROP IN A SHAPE
Open Photoshop, go to File > New, set Background Contents to 
Black and hit OK. Next, drag and drop the shape that you want to 
use. Here we used an outline of a dancer, but you can find many 
other shapes and figures online. Resize the image using Cmd/
Ctrl+T, then hit 2 to set the layer to 20% opacity.

3  WARP THE PAINT
Grab the Forward Warp tool from the toolbar and use the ] and [ 
keys to resize the brush tip. Drag over the image to push the paint 
around so that it follows the body of the dancer. Shape it to cover 
a part of the body using short, sharp pushes with the tool. Hit OK 
when you’re happy.

5  MORE PAINT IMAGES
Change the blending mode of the newly added paint layer to 
Lighten, then, again, go to Filter > Liquify. Once more, set the 
Show Backdrop settings so you can see the dancer shape, then 
use the Forward Warp tool to reshape the paint to match up with 
another part of the figure – the other leg in this instance.

2  COPY IN THE PAINT
Copy in a paint photo and position it roughly over the figure. 
In the Layers panel, set the blending mode to Lighten. Next, go 
to Filter > Liquify. Check ‘Show Backdrop’ in the settings on the 
right, select your shape from the Use dropdown, set Mode to In 
Front, then adjust the opacity slider to suit.

4  ADD A MASK
Go to the Layers panel and click the Add Mask icon, then grab the 
Brush tool and hit D then X to set the colour to black. Paint to hide 
any parts of the paint layer you don’t want to include. Next, drag 
and drop another paint image in, and position it roughly as before.

6  BUILD IT UP
Continue to build up the effect. When you’re done, hide the 
dancer shape layer and add a contrasting paint image as a 
backdrop, dropping it in and changing the blending mode to 
Lighten. Use Hue/Saturation to adjust the colours if you like, 
then add a mask to hide any areas that you need to.

HOW TO CRAFT A PAINTERLY FIGURE

S K I L  L   S



P H O T O S H O P 
LEARN ESSENTIAL EDITING SKILLS FAST!

E D I T I N G

Use this powerful tool to apply a range of tonal and colour adjustments

he Levels command has long 
been one of the most useful 
tonal tools in Photoshop. Not 

only can you use it to lighten or darken 
an image, you can also correct colour 
casts, increase contrast, fix exposure, 
and introduce colour shifts. It’s worth 
noting that if you shoot in raw, it’s best 
to make as many tonal edits as you can 
in Camera Raw before opening the 

image into Photoshop; but if you need 
to alter tones once your image is open, 
Levels offers a fine degree of control.

There are two ways you can apply 
Levels to your photo: either directly to 
an image layer (Image > Adjustments > 
Levels, or press Cmd/Ctrl+L), or as an 
adjustment layer, via the ‘New 
adjustment layer’ icon in the Layers 
panel. Using adjustment layers gives 

you more control, as it means that all 
your edits will be non-destructive, and 
can be fine-tuned at any time.

Adjustment layers work by affecting 
all the layers below them in an image, 
and this means you can build up your 
effects over several layers – in this 
video tutorial we’ll use separate 
Levels layers to correct colours, 
dodge and burn, and add contrast.

T

HOW TO...

DO MORE WITH LEVELS

WANT MORE PHOTOSHOP TUTORIALS? CHECK OUT PRACTICAL PHOTOSHOP
For more Photoshop tutorials, tips and advice subscribe to Practical Photoshop, the world’s premier 
Photoshop magazine. Each month you’ll find an array of inspirational tutorials and accompanying video 
lessons that will help you master Adobe’s industry-leading photo-editing software, plus amazing images 
from the world’s best Photoshop creatives, free downloadable content, and a beginner’s guide to the basics.
iOS: https://apple.co/2GcA3Jc Android: http://bit.ly/2NJASNx Zinio: http://bit.ly/37ke9Qf

DOWNLOAD THE 
PROJEC T F ILES 

ht tps : //b i t . ly/334MqCG

ON A P C OR M AC

WATCH THE V IDEO 
ht tps : //goo.g l /1pzy jL



mpb.com/info/make-good-use

Make good use of your used gear. Clear out your 
kitbag and cabinets, and sell what you’re not using 
to free up funds or trade in towards your next kit 
purchase.

With 250,000 customers and five stars on Trustpilot, 
you can trust us and sleep easy. Free up funds without 
leaving the house. Safe, convenient, fully-insured. 
And completely free of charge.

Make.
Good.
Use.



A reinvented optic for Sony E and Leica L-mount

www.sigma-imaging-uk.com £899/$949

elephoto zooms with a range 
of around 80-400mm or 100-
400mm tend to be quite large 

and heavy – Canon and Nikon’s current 
offerings for their DSLR cameras weigh 
in at 1,640g and 1,570g respectively, and 
they’re both pricey to boot.

In 2017 Sigma launched its ‘light 
bazooka’ 100-400mm, which is only 
about two thirds the weight of those 
lenses, and less than half the price. 
It was very well received, and Sigma 
has now brought out a similar lens for 
mirrorless cameras, available in Sony E 
and Leica L mount options. Tipping 
the scales at 1,140g (Sony) or 1,135g 
(L-mount), it keeps the weight off but 
boasts a redesigned optical path and 
a new autofocus system.

The stepping motor-based AF is 
fast and virtually silent, aided by an 
electronically coupled manual focus 
ring that operates with excellent 
precision. As well as an AF/MF switch, 
there’s an autofocus range limiter 
which operates either side of 6m, 
and an AF-Lock button which can be 
customised for other functions.

T

L E N S  T E S T
EXPERT OPINION ON THE LATEST KIT

Sharpness is very impressive at all focal lengths; 
and, crucially for a relatively ‘slow-aperture’ zoom, 
sharpness is very good when you shoot wide open.

CENTRE SHARPNESS

FRINGING      SHORT 0.14 LONG 0.36

DISTORTION SHORT  1.04 LONG 2.31

Colour fringing is negligible, even at the extreme 
edges and corners. This holds true throughout the 
entire zoom range, and at all available apertures.

Pincushion distortion can be slightly noticeable at 
longer zoom settings, but it’s quite uniform, making 
it easy to correct at the editing stage. 

VERDICT
Typical of Sigma’s Contemporary 
line of lenses, the 100-400mm DG 
DN OS offers good performance 

in a compact and light package, at 
a competitive price. It comes up 

trumps for image quality, delivering 
excellent sharpness and contrast, 
while keeping fringing, distortions, 
ghosting and flare to a minimum. 
It’s pricier than the original DSLR-
mount DG OS HSM version of the 

lens, but the boost in image quality 
justifies the extra outlay.

The older lens for DSLRs featured 
four SLD (Special Low Dispersion) 
elements, and the new DN edition 
supplements these with a top-grade 
FLD (‘Fluorite’ Low Dispersion) element, 
the FLD element being one of the 
largest-diameter pieces of glass at the 
front end of the lens. 

Performance
Autofocus speed is rapid and, in the 
Sony E-mount version of the lens 
that we tested, the AF is well able 
to track fast-moving subjects. The 
optical stabilisation is worth about 
four stops on its own, and works even 
better in conjunction with any in-body 
stabilisation in the host camera.

In both our lab tests and real-world 
shooting, the DN proved consistently 
sharper than the older lens across the 
frame, and throughout the entire zoom 
and aperture ranges. Colour fringing is 
even more negligible than in the older 
lens, though pincushion distortion can 
be marginally more noticeable in the 
300-400mm sector.  
Matthew Richards

SIGMA 100-400MM 
F/5‑6.3 DG DN OS | C

Resolution (line widths/picture height)

Aperture f/5 f/5.6 f/6.3 f/8 f/11 f/16 f/22 f/16 f/22

100mm 1882 1950 1949 1948 1784 1567 1331

200mm 1910 1864 1817 1822 1534 1294

300mm 2022 1928 1932 1473 1267

400mm 1782 1998 1727 1418 1251

Centre sharpness
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DIGITAL CAMERA WORLD
A monthly magazine that aims  
to improve your photography with  
an inspirational mix of amazing 
images and how-to articles.

N-PHOTO
N-Photo is a monthly magazine for 
Nikon photographers, and is packed 
with technique and Photoshop video 
lessons every month. 

DIGITAL PHOTOGRAPHER
The monthly kitbag essential for 
enthusiast and pro photographers, 
packed with tutorials, exclusive 
interviews and the latest reviews. 

PHOTOPLUS
PhotoPlus is a monthly magazine 
for Canon photographers that 
features expert advice, tips and video 
tutorials on all things Canon.

MORE GREAT MAGAZINES FROM  
THE MAKERS OF PHOTOGRAPHY WEEK

SA P P

http://bit.ly/30FoOlQ

https://bit.ly/3lH4ucX

https://apple.co/2vaIdzw

https://apple.co/2SJf6ff

http://bit.ly/3atHLfO

http://bit.ly/2RER7g6

https://apple.co/2TNE26T

https://apple.co/2RBrZqG
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